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Chapter 1: Overview 
 

 

1, 2, 3) Transfer the case data from the defibrillator into RescueNet Code Review via Bluetooth, 
infrared, USB, or serial cable connection. You can also transfer it from the defibrillator’s 
flash card via the card reader. Transfer methods are dependent upon your defibrillator 
model. 

4) Use RescueNet Code Review to review the case and add information as needed. 

5) The system provides a variety of case and aggregate reports, as well as an export function, which 
easily enables you to analyze your data. 
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Chapter 2: Getting Started 

Starting RescueNet Code Review 

 

 

RescueNet Code Review opens with no loaded cases. 
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Opening Cases 
 Search and open cases located in ZOLL CaseReview. 

 

 Upload a stored record by transferring it from an AED Plus™ or AED Pro™ via an 
infrared connection. 

 

Upload a stored record by transferring it from a defibrillator's linear flash card via a card 
reader. 

 

 Upload a stored record by transferring it from a defibrillator via a serial cable connection. 

 

 Upload a stored record by transferring it from a defibrillator via a Bluetooth connection. 

 

Open a stored case by transferring it from a defibrillator’s compact flash card via a card 
reader. 

 

            Open a stored case by transferring it from a USB drive. 

 

            Upload a stored case by transferring it from a network location. 

 

            Upload a stored record from the ZOLL AutoPulse® Noninvasive Cardiac Support Pump via 
an infrared connection. 

 

 Search for and open an existing case located on the local file system or network 

 

 Create a new blank case. You can import a defibrillator or AutoPulse record at any time. 
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Open one of the last five recently viewed cases from the File menu: 

 

 

 Important! If you load a case file that is larger than 75 MB, the following message 

displays: 
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Upload Cases  

CaseReview 

If you are using ZOLL CaseReview, you can upload cases from ZOLL CaseReview to RescueNet 
Code Review to add user-defined CPR periods and pause reasons. Once this is done, you can return 
to CaseReview to view the modified CPR quality metrics including aggregate CPR dashboards. 

Note: Before you upload cases from CaseReview, the CaseReview location must be configured on 
the Options window. You must know the Host URL, Port, user name or DAK/Alternate ID, and 
password.  

 

Some of this information exists in CaseReview under the Settings menu item on the navigation bar. 
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To upload cases from CaseReview: 

1. On the navigation bar, click Search CaseReview . The Search CaseReview window displays. 

2. On the Search CaseReview window: 

a. Upload cases with specific attributes: Upload cases with specific 
attributes: Use the options on the left side of the window to narrow your 
search. As you check an option, the field to the right of the option enables to 
allow you to enter information. After entering the information, click Search. 
Because the search will return a maximum of 1000 cases, it is important to 
enter search attributes to limit the number of returned cases. 

b. A progress bar displays. Once loaded, the cases display at the bottom of the 
page. Double-click a case to open it in Code Review. 
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Infrared  

AED/AED Pro 

 

 

1. Position the AED Plus or AED Pro so that its infrared port lines up with the RescueNet Code 
Review workstation’s infrared port or reader. 

2. In Code Review, click the Upload Case from Infrared button.   

3. On the defibrillator, press and hold the On button. 

4. Keep holding the ‘On’ button until you hear the defibrillator say, "Non-rescue mode. 
Communications established." 

5. In Code Review, a dialog box displays the transfer progress. 
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AutoPulse 

 

 

 

 

 

 

 

 

 

 

1. Position the AutoPulse so that its infrared port lines up with the RescueNet Code 
Review workstation's infrared port or reader.  

2. In Code Review, click the Upload Case from AutoPulse button.   

3. On the AutoPulse, turn ON. Press the Menu key. Select Enter Communication Mode. 
Press ENTER key. 

4. In Code Review, a dialog box displays the transfer progress. 
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USB drive 

AED Plus/AED Pro 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Remove the battery cover from the top of AED Pro by releasing the front latch and 
lifting up on the cover. 

2. Press and hold the Power button on the AED Pro for 5 seconds. 

3. Press the left softkey labeled USB. 

4. Press the left softkey labeled New. 

5. Insert USB drive into USB port located above the battery in upper right corner. 
(You may need to remove the rubber USB port protector.) 

6. The defibrillator recognizes that you inserted the device and downloads data.  It 
announces, “Data download complete”. Remove the USB drive and insert into the 
USB port on your computer. 

7. In Code Review, click Upload Case from USB. The Select drive dialog appears. 
Select the drive letter of the USB drive and click OK. 

8. A dialog box displays the transfer progress. 
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ProPaq M/MD, R Series, Plus, X Series, or M2 

Open case 

1. To copy available cases from the device to a removable USB, 
follow the instructions in the Operator’s Guide associated with 
the device. 

2. Connect the USB device to the computer. 

3. In Code Review, click Open. 

4. Browse to the USB device.  

5. Select the case file(s) to open. 

6. Code Review creates a .zol file for each case and stores it in the 
default data directory. 

USB  

1. To copy available cases from the device to a removable USB, 
follow the instructions in the Operator’s Guide associated with 
the device. 

2. Connect the USB device to the computer. 

3. In Code Review, click the Upload Case from USB button. The select 
drive dialog appears. Select the drive letter of the USB drive and 
click OK. 

4. A dialog box displays the transfer progress. 
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Bluetooth 

M Series/E Series with Bluetooth module 

 

 

 

 

1. Position the defibrillator near the Bluetooth-enabled RescueNet Code Review workstation. 
Bluetooth is omnidirectional with a range of 20 – 30 feet. 

2. In Code Review, click Upload Case from Bluetooth.  

3. On the defibrillator, press and hold the leftmost softkey and turn on the defibrillator. Continue 
holding the softkey until the System Utilities screen displays and then press the Upload Card 
softkey.  

4. On the Upload screen, press the Send softkey. On the E Series, press Bluetooth before you 
press Send. 

5. In Code Review and on the defibrillator, progress bars display the transfer progress.  

http://www.zolldata.com/
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Card reader 

M Series/E Series/R Series and 1600/1700 

 

 

1. Insert the defibrillator’s flash card into the RescueNet Code Review workstation’s card reader. 

Note: Inserting the card may prompt the Windows “New Hardware Found” wizard to appear and 
request to search for drivers.  The system installs the necessary drivers with Code Review.  You can 
prevent this message from appearing every time you insert the card by informing Windows not to 
prompt for drivers again. To do this, click Next, Next, Finish.  

2. In Code Review, click the Upload Case from Card Reader button. A progress bar displays 
transfer progress.  

3. When the transfer is complete, you can erase the card and re-use it in either an M Series/E 
Series or 1600/1700 defibrillator. 
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Serial 

M Series/E Series 

 

 

1. Connect the defibrillator to the RescueNet Code Review workstation's serial port. For the M 
Series/E Series, you must use the ZOLL RS-232 Data Transfer Cable (ZOLL part number 
8000-0605-01), which terminates in a female DB9 connector. For the 1600/1700, you must use a 
ZOLL 1600 Serial Link Cable and Connector (ZOLL part number 8000-1614).  

2. In Code Review, click the Upload Case from Serial button.  

3. On the defibrillator, press and hold the leftmost softkey and turn on the defibrillator. Continue 
holding the softkey until the System Utilities screen displays, and then press the Upload Card 
softkey. On the Upload screen, press the Send softkey. On E Series, you will need to press RS 
232 before pressing Send. 

4. In Code Review and on the defibrillator, progress bars display transfer progress.  

 

Note: For serial uploads using the 1600/1700 defibrillator, refer to the 1600/1700 Operator’s 
Guide. 
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Wi-Fi 

R Series Plus and X Series 

On the defibrillator, use the transfer instructions found in the Operator’s Guide for your device. 

1. When you save to Wi-Fi, the system places the files in a “Full disclosure files” location on the 
configured server.  In Code Review, you can rectify that location by going to Tools > Options > 
Network > Full disclosure files location.  

2. To upload the files to Code Review, click the Upload Case From Network icon . The system 
retrieves the files from the full disclosure files location. 
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Search for Cases Previously Uploaded in CaseReview 

See the ZOLL CaseReview User Guide for more information on how to configure and use the Search 
CaseReview application. 

Search for cases previously uploaded 

1. Click the Search button.    

2. Select any combination of criteria (A), and then click Search (B). 

 

3. The system lists all cases that match that criterion. You can click any column header 
to sort by that column (A), select the case or cases you want to open (B), and then 
click Open (C). 

 

Note: If you are archiving or sorting your cases into subfolders of the Default data files location 
folder, the Also search subfolders option (D) enables you to search those folders at the same time as 
the Default data files location folder. 
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Chapter 3: View Cases 

Navigate the Case Tree 

1. Case date: 

       

2. Patient name: 

       

3. Case ID (date/time, preference by run number, if any): 

       

     The case initially opens with a status of Not Viewed. 

      

     After five seconds, the status changes to Viewed.  

 

4. Case events (click any event to display its data on the tabs):  
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 M Series event 

 
M Series shock 

 M Series 12-lead event 

 E Series event 

 E Series shock 

 E Series 12 lead event 

 
R Series event 

 
R Series shock 

 X Series/Propaq event 

 X Series/Propaq shock 

 X Series/Propaq 12-lead event 

 
M2 shock 

 
M2 shock 

 
AutoPulse event 

 AED Pro event 

 AED Pro shock 

 AED Plus event 

 AED Plus shock 

 
1600/1700 event 

 1600/1700 shock 
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 User-added note 
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Select the Type of Events to View 
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Turn On/Off Audio Prompts (AED Plus/AED Pro) 

 

 

 

 

Note: To see how the case tree size changes depending on the audio prompt settings, see below. 

Default view – include audio prompts 
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Optional view 1 – include extended audio prompts 

 

Optional view 2 – audio prompts off 
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Select Data Tabs to Display 

 

 

 

 

 

Note: The 12-Lead, Code Record, and Prehospital Utstein tabs are available in the RescueNet Code 
Review Enterprise edition. 
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General information 
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Tags 

Under the General > Case section, apply a tag to a mark a case so you can easily find in in the future 
for further analysis. You can apply a tag to any type of case.  

If you upload a case from CaseReview that has applied tags, the tags will display in the Tags field.  

If you apply a tag using Code Review and then upload the case to CaseReview, the tag displays on 
the CaseReview Manage page when you view the case. 

You can view all the tags configured in the system, add a new tag, or edit an existing tag.  

1. Click Edit Tags. The system displays a list of configured tags. 

 

2. Use an existing tag: 

a. Click a tag to highlight 
b. Click > to move the tag to the Selected tags column 
c. If you wish to apply multiple tags to the case, continue selecting the tags and 

moving them to the Selected tags column 
d. When you are finished, click OK. The tags display in the Tags field. 

3. Create a new tag: 

a. Click Create New 
b. Enter the tag name in the window and click OK 
c. The tag name displays in the Available Tags list 
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Entire ECG 

 

a) Grid size is 1.00 s x 1.00 mV at Gain x 1  

b) 6-second reference box   

c) Midpoint   

d) Click scroll arrow to move 00:00:30. Click in scroll box to move 00:02:00  
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Magnified ECG and Animation 

To view a magnified portion of the ECG, click the portion you want to magnify on the entire ECG. 

 

On the other hand, in the case tree, click the event you want to magnify. 

 

Alternatively, to display the portion of the entire ECG in the reference box, click the 3 – Magnified 
ECG tab. 
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The system displays the selected portion of the ECG on the Magnified ECG tab. 

 

Animated ECG controls. 
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Magnified ECG – Display large view 
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Magnified ECG – Display event text 
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Advanced parameters 

The system displays advanced parameters on the Magnified ECG tab in RescueNet Code Review – 
Enterprise edition. 

 

A) Midpoint 

B) Advanced parameters measurements at midpoint 

C) The lower graph displays the advanced parameters waveforms. If the data is 
available, the system can show as many as three advanced parameter waveforms 
at one time.  

Note: When using Propaq M/MD or X Series, the numeric values change at 30-second intervals. 
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To change views for an advanced parameter waveform graph: 
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CPR (AED Plus/AED Pro/M Series/E Series/X Series/R Series/M2) 

The Magnified ECG tab displays CPR compression depth and rate measurements along with the 
CPR Bar graph. 

 

Note: CPR recording is contingent on the defibrillator software version and configuration. 

See-Thru CPR® (filtered ECG) 

If the defibrillator records See-Thru CPR® (filtered ECG), the system draws two waveforms on the 
ECG. As demonstrated in the above image, the system draws graph an unfiltered waveform on the 
top and a filtered waveform on the bottom. 
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CPR Analysis 

CPR Analysis is available for cases recorded on an AED Plus, AED Pro, AED 3, M Series, E Series, 
R Series, X Series or M2 when CPR-D Padz was used. CPR Analysis also includes manual and 
AutoPulse compression information if the AutoPulse data is transferred via infrared. 

Target zones 

Target zones can be set to measure accuracy of compression rate and depth. 

 

http://www.zolldata.com/


                                                                                                         

 

Chapter 3: View Cases  

Page 35 

11802 Ridge Parkway, Suite 400 
Broomfield, CO 80021 U.S.A 
Tel: (303) 801- 0000 
Fax: (303) 801- 0001 
Latest docs: www.zolldata.com 

Z
O

L
L

 
D

o
c

u
m

e
n

t
a

t
i

o
n

 
 

 
 

   
 
 
 
 
 

 

View 

Click the magnifying glass to change the view from entire case to 30-second segment. 
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CPR periods 

The CPR period defines which compression data to include in the CPR Summary.   Compressions 
recorded outside of the defined CPR period are ignored. There are two ways to define the CPR 
periods in a case: 

 CPR prompt – automatic; defined by the number of defibrillator prompts for 
start/stop compressions that were recorded during the case. 

 User-defined – manual; defined by user drawn start/end CPR periods on the 
Entire ECG or Magnified ECG tabs. 

You can choose the mode for defining the CPR periods and whether to display the yellow 
boundaries on all graphs in Code Review.  The system calculates the total number of boundaries 
(automatic or manually drawn) for you. 

 

 

Notes:  

 For defibrillator running in ‘Manual mode’, the automatic boundaries (mode: CPR prompt) 
are defined by the first CPR-D Padz onto the last CPR-D Padz Off or Case End. 

 Compression data originating from the AutoPulse is not included in automatically drawn 
CPR boundaries (mode: CPR prompt) and must be manually drawn in mode: User-defined. 

 The system connects the plotted points on the Rate graph within the boundaries of a CPR 
period only.  

 In AED mode, the R Series records CPR periods that users can view in Code Review using 
the ‘CPR Prompt’ mode on the ‘CPR Analysis’ tab. The R Series does not display CPR 
Periods when it is in ‘Manual mode’. 
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To create a user-defined CPR period on the Magnified ECG tab, first start a boundary: 
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To end the boundary: 
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Drawing a CPR pause 

Sometimes there are gaps in the delivery of compressions during a CPR Period. To annotate these 
time periods of missing compressions, a CPR Pause Period can be drawn and a reason for the pause 
can be included. 

To create a user-defined CPR Pause period on the Magnified ECG tab, first start a boundary: 
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To end the boundary: 

 
 

Select a CPR pause reason and click OK. 
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The system draws a blue-shaded segment that indicates the boundaries of the CPR Pause. The 
selected reason displays on the strip as Event Text. 

 

Summary 

The system displays an analysis of the defined CPR periods in the Summary section. 
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CPR Quality Calculation 

The CPR Quality Calculations tab shows the physiologic waveform data timeline and the minute-by-
minute analysis of the CPR quality parameters. The system automatically annotates the timeline with 
markers to indicate compressions and ventilations when the recorded data is available. You can 
manually add ventilations as well as ROSC periods. 

Timeline 

Select which waveform to view on the timeline by right-clicking the context menu button on the 
first graph. 

 

The system displays a full minute across the four physiological waveform graphs. You can select 
which minute of waveform data the system displays by using the Minute drop down list available at 
the top of the tab. 

 

You can also use the scroll bar arrows under the waveform graphs to move forward or backward by 
one minute or jump to the beginning or end of the case. 
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Annotating Compressions and Ventilations 

The system produces compression markers from compression data stored by the defibrillators. 
When data is available, the system also annotates ventilation markers to indicate the impedance, 
derived from Pads or Leads, and/or breath detection from CO2.  You can also manually annotate 
the timeline with ventilation markers.  

C markers 

Compressions are marked with a bold C icon.  Green indicates a compression with depth in range 
and orange indicates a compression with depth that is out of range. The depth range for 
compressions is set on the CPR Analysis tab. See the CPR Analysis tab, Target Zones, for 
instructions on setting the depth range target zone. 

Note: You cannot manually add or delete a compression marker.  

 

V markers 

Ventilations/Respirations are marked with a bold V icon. 

 

Note: The system places automatically generated ventilation markers higher on the timeline with 
manually annotated markers lower on the timeline.  

The ventilation markers displayed are based on the user selected Vent. Source. The Vent. Source 
menu is available at the top of the tab and defaults to CO2.   
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CO2: The system automatically annotates CO2 based ventilation markers when the CO2 data 
contains breath detection information.  

Pads Impedance: The system automatically annotates Pads impedance based ventilation markers 
when Pads impedance data is available. 

Leads Impedance: The system automatically annotates Leads impedance based ventilation markers 
when Leads impedance data is available. 

Manual: The system displays the user created ventilation markers on the timeline. 

Note: Choosing a new Vent. Source causes the timeline to be redrawn showing the chosen set of 
ventilation markers. 

Adding, deleting, ventilation markers 

Ventilation markers can be added or deleted by right clicking on the timeline and then choosing 
Ventilation, then Add, Delete or Delete All. 

 

Note: Selecting Delete All will delete all ventilations in the current minute only. 
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Adding annotations 

You can insert an annotation event into the timeline by selecting Add Annotation in the context 
menu. For more information on how to add an annotation, see Adding Annotations. 

 

 

 

After saving the annotation, the event is marked with the push pin icon. 

 

 

Adding ROSC periods 

Draw ROSC boundaries with a simple right-click at a point in time on the graph or with a more 
precise method, by manually entering a specific time. 
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Create a ROSC Start event with a right-click on the graph at the point in time to begin the ROSC 
boundary; in the context menu, select ROSC, Start. Next, create a ROSC End event with a right-
click on the graph at the point in time to end the ROSC boundary. In the context menu, select 
ROSC, then End. The ROSC period is shaded as shown below. 

 

 

Alternately, you can enter the ROSC Start and ROSC End times manually by right clicking anywhere 
on the graph and clicking ROSC. Select Enter Start Manually or Enter End Manually as 
appropriate.  

 

  

 

You can delete any user created ROSC period via the context menu by right clicking anywhere 
within the ROSC period drawn on the graph and clicking ROSC, then Delete. 
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CPR Performance Summary Data 

Use the CPR Performance Summary table for minute-by-minute analysis of the CPR data after you 
have made the desired edits for compressions, ventilation, and or ROSC periods to the timeline. 

 

Note: Click on a row to display the selected minute the same as if you selected the minute from the 
dropdown at the top of the tab. 

Minute:  Minute count from start time 

Sec w/o Comp: Seconds in this minute without compressions 

Vents:  Manually marked vent count for minute 

Vents CO2:  
Ventilations reported from CO2 monitoring (Breath 
detection) 

Vents Leads: Respirations detected from leads impedance signal 

Comp. Count: Compression count for minute 

Mean Comp. Depth: Depth: Average compression depth 

Comp. Rate: Rate: Average compression rate 

Mean Release Velocity: Average over the minute shown in millimeters per second. 

Comp. Fraction:  Percentage of minute with compressions 

Unanl. Sec.:  
Un-analyzable Seconds, the number of seconds that were 
not analyzed 

Comp. In Target Depth: Percentage of compressions in target depth for minute 

Comp. In Target Rate: Percentage of compressions in target rate for minute 
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Choosing the Start Time for Minute-by-Minute Analysis 

You can choose to set the start time for the minute-by-minute analysis to Power On, Pads On, or 
manually set. When you change the start time selection, the system recalculates the minute-by-
minute results. The system automatically calculates and provides the Pads On and Power On times 
from the case data in the dropdown. 

  

Creating a manual start time 

To set the manual start time, right click on the timeline and choose Manual Start Time, then Set. The 
system adds the Manual start selection to the start time list as shown above. 

 

Print/Export CPR Performance Summary Data 

You can save and/or generate a report of the columns shown in the CPR Performance Summary 
Data.  

Export: Click the  icon and choose a file location. The system exports the data to a .xml 
file. 
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Print: There are two ways to generate a report: 

1. On tab 5, click the Print icon  under the CPR Performance Summary Data 
heading, choose a local network printer, and click OK. 

2. On the navigation bar:  

a. Click File 

b. Hover over Print and Case 

c. Click CPR Performance Summary Data 

d. On the Print Setup window, choose a local printer and click OK 
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12-lead 

The 12-lead tab is available in RescueNet Code Review - Enterprise Edition. 

 

 

a) Zoom in/out 

b) View previous/next 12-lead event in currently selected case 
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Cabrera Format 

To change the display of the 12-Lead 4x3 to Cabrera format on the 12-Lead tab, Go to Tools > 
Options > View and select Display 12-Leads in Cabrera format.  

 

Note: This setting is for X Series only. If an E or M Series recorded a 12-Lead in standard format, it 
will still display in standard format on the 12-Lead tab. 
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Closing Cases 

When you exit RescueNet Code Review, cases are automatically closed. 

You can manually close an open case. 

 

You can also manually close all open cases. 
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Snapshot 

The Snapshot tab is available in RescueNet Code Review - Enterprise Edition. This tab displays 
snapshots recorded by the X Series. 

 

 

 

 

 

Use the provided buttons to print the snapshot(s), zoom in/out, and view the previous or next 
snapshot. 
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Closing Cases 

When you exit RescueNet Code Review, cases are automatically closed. 

You can manually close an open case. 

 

You can also manually close all open cases. 
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Snapshot 

The Snapshot tab is available in RescueNet Code Review - Enterprise Edition. This tab displays 
snapshots recorded by the X Series. 

 

 

 

 

 

Use the provided buttons to print the snapshot(s), zoom in/out, and view the previous or next 
snapshot. 
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Chapter 4:  Documenting Cases 

Reviewing and Adding Information 
To review and make changes to code information, download or open the case. To quickly search for 
a case that a user previously downloaded, combine the date range and, optionally, other search 
parameters. 

Saving Changes 

Whenever there are unsaved changes, the Save button is enabled.  

 At any time, you can click the Save button to manually save changes. 

 If you close a case with unsaved changes, a message asks if you want to save 
them. 

Note: When you move from viewing one case to another, unsaved changes in the first are preserved, 
but not saved. If you return to the original case, your changes will still be there. However, if you 
close that case without saving, your changes will be lost. 

Adding Annotations  

1. On the magnified ECG, right-click on the time you want to add an annotation. 
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2. Add the title and optional text. 

 

3. The system displays the annotation title on the ECG and in the case tree. 

 

 

4. To edit, view, or delete an annotation: 
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Code Record 
The Code Record tab is available in the RescueNet Code Review - Enterprise edition. 
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Prehospital Utstein 
The Prehospital Utstein tab is available in RescueNet Code Review - Enterprise edition. 

Accurate Utstein reports depend on complete data. As you begin capturing prehospital Utstein data 
for a case, additional field labels might be displayed highlighted red to indicate that they are also 
required. As long as the prehospital Utstein data is incomplete for a case, the tab title is displayed 
red. (Completeness is only measured for confirmed cardiac arrest cases.) 

 

When you have captured complete Prehospital Utstein data, the tab title and all labels are black. 
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Note: You can still save a case with incomplete Prehospital Utstein data (in that case, a message 
notifies you of the incompleteness). To ensure accurate reports even if you have cases with 
incomplete Utstein data, when you search for cases to include in the Utstein report, configure your 
search criteria to include cases that have complete Utstein data only. 
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Chapter 5: Reporting 

Case Reports 

 

CPR Analysis Summary Report 
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Incident Log 
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Strips 

For strips, you can print a full disclosure (for entire case or a specific time range) or an event 
summary report (for all events or selected events). 
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The Event Summary report displays at least 15 seconds before and after each instance of the 
selected events. 

 

If there is a gap of no activity for the selected events, the system displays a time gap notification. 

 

Note: RescueNet Code Review - Enterprise edition includes these additional case reports: 

 12-Lead Events  

 NIBP History Table  
 Vital Trends Table  

 Vital Trends Graph 
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Aggregate Reports 
Aggregate reports are available in RescueNet Code Review - Enterprise edition. 

1. Select an aggregate report to print. 

 

2. The Search for File to Include in Report dialog box automatically opens. Select any 
combination of criteria (a), and then click Search (b).  

 

3. Cases that match your criteria display. Select the cases that you want included on the 
report (c), and click Run Report (d). 

The report displays in a browser window.  
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Printing ECG Segments 
1. Right-click to select a segment you want to print.  

 

2. The selected segment highlights. 
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3. Optionally, you can select additional segments anywhere on the ECG. 

 

4. You can view all selected segments on the Entire ECG tab. 

 

5. To print all selected segments: 

 

6. Select Current selection option. 
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Chapter 6: Advanced 

Mark Cases Viewed/Not Viewed 

To manually control the status: 

 

Once you manually change the status to Not Viewed, it remains in that status until: 

 You manually change it to Viewed.  

 You close it, and then reopen it.  

 You view another case, and then return to viewing the one with the manually 
changed status.  

You can also force status changes to be manual. 
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Renaming Cases 
Cases are stored as .zol files. By default, the files are named with the date and time of the 
defibrillator when the case was created, plus the serial number of the defibrillator (if available), for 
example, 20060328132727_00000017.zol. 

You can rename a case file and, optionally, save the renamed file in another location. 
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Sending Case to a Folder or Email Recipient 
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Exporting Data 
1. Open the case you want to export.  

2. Select the type of export. 
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Inserting Defibrillator Records into Cases 
If you have a case that does not have a defibrillator record, you can insert one into it. 

1. Open the case. 

2. Select the source of the defibrillator record. 
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Inserting AutoPulse Records into Cases 
If you have a case that does not have an AutoPulse record, you can insert one into it. 

1. Open the case. 

2. Select Insert AutoPulse Record and place the AutoPulse in upload mode. 

 

Documenting HIPAA Disclosure 
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Linking Cases 
1. Drag the case you want to link (a) to the case you want to link it to. As you're 

dragging, you'll see a lighter version of the case symbol (b). 

 

 

2. The system displays linked cases with a double caduceus symbol followed by the 
number of linked cases in parentheses. 

 

Unlink Linked Cases 
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Case Times and Synchronization 
Whenever possible, the system automatically synchronizes the defibrillator event times to the clock 
on the RescueNet Code Review workstation. You can also manually adjust the case start time and 
the defibrillator times. This enables you to ensure that the times for your cases displayed in 
RescueNet Code Review are consistent. 

Note: To ensure correct current time, keep the RescueNet Code Review workstation 
synchronized to an accurate time source.  

There are three key times: the case start time, the defibrillator power on time, and the adjusted 
power on time. 

Case Start Time 

The case start time is the time the case actually started, which could coincide with the defibrillator 
power on time or an earlier, non-defibrillator event. 

 

Defibrillator Power On Time and Adjusted Power On Time 
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The read-only defibrillator power on time, which is always the first defibrillator event, is based on 
the defibrillator clock. When possible, the system synchronizes it to the clock on the RescueNet 
Code Review workstation. (Depending on your view options, the system may not display the power 
on time in the case tree, but will still display the time on the General tab.) 

The times displayed in RescueNet Code Review for all defibrillator events are based on the adjusted 
power on time, which initially is usually the same as the defibrillator power on time. You can 
manually control the displayed defibrillator event times by adjusting this time. 

The Relationship between Case Start Times and Adjusted 
Power On Times 

 The case start time must always be equal to or earlier than the adjusted power 
on time.  

 You can manually adjust the case start time to a time that is earlier than the 
adjusted power on time.  

 If you manually adjust the adjusted power on time to be earlier than the current 
case start time, the system automatically adjusts the case start time to be equal to 
the new adjusted power on time.   

 If you add an event that occurred before the current case start time, the system 
adjusts the case start time to be equal to the time of the added event.  

 It is not possible to adjust the case start time to be later than the adjusted power 
on time nor the time of the first non-defibrillator event time. 

New Blank Case 

 

Created with the case start time = the current time. Initially, there is no defibrillator data or times.  
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Upload from Infrared, Serial, Bluetooth, or Downloaded via 
ZOLL Data Retriever  

       

If RescueNet Code Review is able to determine defibrillator power on time: 

 The system synchronizes the defibrillator power on time to the RescueNet Code 
Review workstation clock.  

 Adjusted power on time = defibrillator power on time.  

 For all others, case start time = adjusted power on time (= defibrillator power 
on time). 

If RescueNet Code Review is unable to determine defibrillator power on time: 

 Defibrillator power on time = "Unable to determine."  

 Adjusted power on time = current time.  

 Case start time = adjusted power on time (= current time). 

Note: For cases downloaded via ZOLL Data Retriever, it is presumed that the mobile device time is 
in-sync with the RescueNet Code Review workstation. Prior to using Data Retriever, ensure that this 
is the case by docking the mobile device to the RescueNet Code Review workstation. This triggers 
an automatic synchronization of the mobile device clock to the workstation clock.  

Upload from Card Reader, USB Drive, or Compact Flash 

    

Time synchronization cannot be performed as time continuity is lost when the card is out of the 
defibrillator or there is not a direct data transfer from the defibrillator to RescueNet Code Review. 

 The system displays the defibrillator power on time as recorded on the card.  

 Adjusted power on time = defibrillator power on time.  

 Case start time = adjusted power on time (= defibrillator power on time). 

Insert Defibrillator Record into an Existing Case 

Follows the same rules as when creating a new case from the same source, with one exception: the 
new case start time = the earlier of the adjusted power on time or the existing case start time. 

Note: Insert Defibrillator Record from Card File follows the same rules as Insert Defibrillator 
Record from Card Reader. 
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Chapter 7: Administration 

Controlling Access / Using in a Networked Environment 

Using groups to control access to RescueNet Code Review  

For a standalone installation, set up these groups on the workstation. For an environment in which 
multiple users are sharing case files over a network, set up these groups in the Windows domain or 
Active Directory. When these groups exist, the user logged on to Windows must be a member of a 
group to access its associated item. 

 ZDUsers. Only members of this group can start RescueNet Code Review.  

 ZDAdmins. Only members of this group can access Tools › Options.  

 

Note: Group names are specific and cannot be altered. You need to add them as a global security 
group. The system does not support Novell networks.  

Using RescueNet Code Review in a networked environment 

All instances of the program should point to one default data files location, which all users can 
access, share, read, and write to. 
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Ignoring Test Cases 

You can control whether the system ignores test cases when a user opens a new case from infrared, 
a card reader, a serial connection, or Bluetooth or attempts to attach a case. Test cases are defined as 
cases with 30 joule shocks, patient impedance of less than 15 ohms, and in which internal paddles 
were not used. 

 

Ignore Previously Uploaded Cases AED Pro/AutoPulse 

You can control whether to upload only new cases from the AED Pro and AutoPulse or all 
recorded cases including cases that have been previously uploaded. 
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Configure Case Transfer Settings 
When you upload a case from infrared, a card reader, a serial connection, or Bluetooth, the transfer 
is controlled by the settings on the associated Options tab.  

Card reader 

The Internal option works for most internal card readers in notebook PCs. If the default memory 
window does not work, you can click Detect to find the first free memory window. You can also try 
manually selecting the memory window to find one that works. Click Test to determine whether the 
selected memory window is a valid choice for use with a card reader. 

You can optionally choose to erase cards automatically after they are successfully read. This makes it 
possible to use the card next in either an M Series/E Series/R Series or 1600/1700 defibrillator. 

Serial and Bluetooth 

The COM port must match the COM port used on the PC by the serial or Bluetooth device. The 
defibrillator baud setting in CodeNet Central must match the baud setting configured in the 
defibrillator (see your defibrillator manual for details). 

 For the M Series/E Series, the default setting is 115200  

 For the 1600/1700, the default setting is 57600 

Serial transfer technical note 

 M Series/E Series. You must use a ZOLL RS-232 Data Transfer Cable 
(ZOLL part number 8000-0605-01), which terminates in a female DB9 
connector. 

 1600/1700. You must use a ZOLL 1600 Serial Link Cable and Connector 
(ZOLL part number 8000-1614). 

Checking for Software Updates 

To enable or disable the Check for Software Updates option: 
Tools › Options › Enable software updates. If you enable this 
option, the menu item will appear under Help.   
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Upgrading 

You can upgrade RescueNet Code Review Standard to the Enterprise edition.  

To purchase an upgrade license, contact your ZOLL Medical Regional Sales Manager. 

To upgrade, enter the license code on the Tools › Options › System tab. 

RescueNet Code Review Standard Edition 

The RescueNet Code Review Standard Edition has the following features: 

Tabs 

 General 

 Entire ECG 

 Magnified ECG 

 CPR Analysis 

 CPR Quality Calculation 

Case Reports 

 12-Lead Events 

 HIPAA Disclosure 

 Incident Log 

 Snapshots 

 CPR Analysis Summary 

 CPR Performance Summary Data 

 Strips 

Exports 

 Waveform Data 

 Event Data 

 12-Lead Data 

 Entire Defibrillator Record 

 Patient/Case Data 

 Audio Data 

 CPR Performance Summary Data 
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RescueNet Code Review Enterprise Edition 
RescueNet Code Review Enterprise Edition has the following additional features: 

Tabs 

 General 

 Entire ECG 

 Magnified ECG 

 CPR Analysis 

 CPR Quality Calculation 

 12-Lead 

 Snapshot 

 Code Record 

 Prehospital Utstein 

Case Reports 

 12-Lead Events 

 HIPAA Disclosure 

 Incident Log 

 Snapshots 

 CPR Analysis Summary 

 CPR Performance Summary Data 

 NIBP History Table 

 Strips 

 Vital Trends Graph 

 Vital Trends Table 

Aggregate Reports 

 CPR Analysis Summary 

 EMS Frequency by Collapse Location 

 EMS Resuscitation Summary 

 Pre-hospital Utstein 

 Search Results 

Exports 

 Waveform Data 

 Event Data 

 12-Lead Data 

 Entire Defibrillator Record 

 Patient/Case Data 

 Trend Data 

 Audio Data 

 CPR Performance Summary Data 
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Chapter 8: Getting help 
If you are a ZOLL customer in the United States, use the following contact information for 
questions or information concerning software sales, upgrades, and support: 

ZOLL Medical Corporation 
269 Mill Road 
Chelmsford, MA 01824-4105 USA 
Telephone: toll free (800) 348-9011 or (978) 421-9655 
E-mail: SupportData@zoll.com 
Fax: (978) 421-0015 
Web: www.zoll.com 

If you are a ZOLL customer in any other location, either send e-mail to SupportData@zoll.com or 
contact your nearest authorized local ZOLL representative.  

Web for International offices: http://www.zoll.com/contact/worldwide-locations/ 

 

 

http://www.zolldata.com/
mailto:SupportData@zoll.com
http://www.zoll.com/
mailto:SupportData@zoll.com
http://www.zoll.com/contact/worldwide-locations/

